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Installing Eclipse (C++/]ava)

The 2017 suite of text-based languages, Java and C++, utilize the current version of Eclipse as a
development environment. The FRC specific tools for the chosen language are installed as
Eclipse plugins. You can install both the Java and C++ development tools into the same
installation of Eclipse to allow programs to be written with either language using a common
set of tools and user interface.

The 2017 Eclipse plugins have been tested with Eclipse Luna, Eclipse Mars and Eclipse Neon.
Teams with existing installs from 2016 can update their installations to 2017 by following the
updating the plugins when prompted by opening Eclipse (if automatic update is enabled) or
following the Updating the plugins manually instructions below. C++ teams should also install
the new toolchains (Installing the C++ Toolchains).

CAN Talon SRX has been removed from WPILib. See this blog for more info and find the CTRE

Toolsuite installer here: http://www.ctr-electronics.com/control-system/
hro.html#product_tabs_technical_resources

Note: The C++ and Java tools and environment are available for Windows, Mac OSX and Linux,
though the Windows version is the one that has been the most heavily tested. You should be
able to use any of the three for your development platform, however you should keep in mind
that you will need a Windows computer to run the Driver Station software and roboRIO
Imaging tool.

Installing Eclipse (C++/Java) Last Updated: 01-07-2017 Page 1


http://www.firstinspires.org/robotics/frc/blog/2017-control-system-update
http://www.ctr-electronics.com/control-system/hro.html#product_tabs_technical_resources
http://www.ctr-electronics.com/control-system/hro.html#product_tabs_technical_resources

Installing Eclipse (C++/Java)

Getting Java

Java SE Development Kit 8ull

¥You must accept the Oracle Binary Code License Agreement for Java SE to download this
software.
| Accept License Agreement Decline License Agreement
Product / File Description File Size Download
Linux x86 133.58 MB  # jdk-8Bu11-linux-i586.rpm
Linux x86 152.55 MB  # jdk-Bu11-linux-i586.tar.gz
Linux x64 13389 ME ¥ jdk-Bu11-linux-x64.rpm
Linux x64 151.65 MB % jdk-8u11-linux-x64.tar.

Mac OS5 X %64
Solaris SPARC 64-bit (SVH
Solaris SPARC 64-bit Ll
Solaris x64 (3VR4 package) 135.7 MB

jk-8011-solaris-x64d tar.Z

Windows x86 15181 ME ¥ jdk-8u11-windows-i586.exe
Windows xG4 15529 ME ¥ jdk-8u11-windows-x64 exe

To use Eclipse you must have Java JDK installed on your system. You can get Java from the web
site: http://www.oracle.com/technetwork/java/javase/downloads/index.html. Select "JDK
Download", then scroll down the page to "Java SE Development Kit". Accept the license agreement
and download the Java SDK for your platform. The version (either x86 or x64) should match the
version of Eclipse that you have installed or plan to install on your computer. This has been tested
with Java SE 8u11 but will probably work with later versions as well.

Java 8 is installed on the RoboRIO and to take advantage of all the features it offers, it is suggested
that you use Java 8 on your development system. You may use an earlier version, however it
should be noted that the Java-installer program for loading the JRE on the roboRIO requires Java 8
(so you will need at least one computer with it) as does the rioLog Eclipse plugin which is used to
view console output.

Note: Java is required to be installed even if you are doing C++ development since Eclipse, the

development environment, is a Java program. Also, the Oracle web page might change over time,
so the images shown here might not exactly match what you see.
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Installing the C++ Toolchains (C++ teams only)
- 1] FRC Toolchain Setup‘ E|_|_J"

Please read the FRC Toolchain License
Agreement

GNU GENERAL PUBLIC
LICENSE

Wersion 3, 29 June 2007

Copyright @ 2007 Free Software
Foundation, [ne. <http:/fsf.ore >

FIRST Robolics Compelition

Fvervone is permitted to copy and
distribute verbatim copies of thiz license
document, but changing it is not allowed., -

[¥]1 accept the terms in the License Agreement

Back [ Install ] [ Cancel ]

")

Download the appropriate C++ Toolchains installer for your platform from http://first.wpi.edu/FRC/
roborio/toolchains/

Note: Remaining Toolchain installation instructions describe Windows installation, instructions for
the other two platforms are listed on the download pages.

Note: The Windows toolchains will install to the drive the installer is run from. To install from a USB
drive, make sure to copy the installer to a permanent drive on the computer before running it. If
you accidentally install in the wrong location, run the installer again and select "Remove" to
uninstall, move the installer to the desired drive and then re-install.

Windows: Double click on the downloaded file to launch it. If you receive a Security Warning, click
Run. Check the box to accept the License Agreement, then click Install. When the install completes,
click Finish.

Mac OSX: Double-click on the downloaded file in Finder to unzip it. In Finder, right-click on the "FRC

ARM Toolchain.pgk" file, then press the option key on your keyboard, and click "Open". Follow the
steps to install the package.
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Linux: See the instructions in the text file on the toolchains page.

Getting Eclipse

eclipse n

L : ™ Q7
Are you rea dy forjava 8: Become a Friend of Eclipse

Eclipse Luna includes official support for Java 8 in the Java development tools, Plug-in _

Dev ment Tools, Object Teams, Eclipse Con on Framework, Maven integration,

BCH} Barcelona JUG GBarce

Masialmmar bamsmsmmi s aall Basis sie

You can get eclipse from the web site: http://www.eclipse.org then press the "Download" button to
select the version to be used.

Download Eclipse

T Windows
I'-'q-" 166 ME 912911 DOWRNLOADS

ke

The essential tools for any Java developer, including a Java IDE, a Git client,
XML Editor, Mylyn, Maven integration and WindowBuilder...

32/64 should match Java version

o
li - 176 ME 377,192 DOWNLOADS

ke

An IDE for Cf/C++ developers with Mylyn integration.
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Select the version of eclipse that matches your desired programming language (there are
instructions below for adding C++ to Java or Java to C++). You should choose the version of eclipse
that matches your operating system and version of Java from above.

At the time of this writing the current version is Neon (4.6) and that is what we've been using for
development of the tools. On the next screen choose a download site and start the download.
Choose a location such as the downloads folder for the zip file.

Note: on 64 bit Linux systems it might be necessary to install 32 bit version of libc. For example, on
Ubuntu Linux, the command would be:

sudo apt-get install 1ibc6-1386

This is necessary to run the gcc binaries as part of the plugins since they are compiled for 32 bit
linux.

Unpack the eclipse folder and move it to Program Files

|

I\‘:/,H\:J ‘ & b brad » Downloads » v|¢¢|| Search Downloads
Crganize = = Open - Share with - Burn Mew folder == -
A Favorites " Mame . Date modified Type Size
Bl Desktop 1. eclipse:rnn-kenler-SR1-win3? 10A7/2013 4:29 PM  Compressed (zipp... 143,586 KE
& Downloads Open I

I}

& Dropbox (Mac) |- Open in new window
(& iCloud (Mac) L
|E| Photao Stream (M Prm—

Ei Recent Places Show in Finder

| (- Open with »
3 Libraries

| Documents Share with 3

Extract the contents of the zip file by right-clicking on the .zip file in a windows explorer window
and selecting "Extract All..." and taking the default for the location to extract it.
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Move the extracted eclipse folder to Program Files

o Music “  Mame

Date modified ype

= Pictures
B videos

(B Computer
&L, Lecal Disk (C:)

. Program Files

. Windows
@ OVD Drive (D:) P2
a— v Bosnk (W21

10/17/2012 4:37T PM  File falder

Move the extracted folder to Program Files or some other convenient location from which to easily
run it. Within the eclipse folder you'll see the file "eclipse.exe". You can right-click on "eclipse.exe"

and select "Pin to start menu" to make it easier to run eclipse without having to find the
installation location.
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Starting Eclipse for the first time

'3 Workspace Launcher

Select a workspace

Eclipse stores your projects in & folder called a workspace.
Choose a workspace folder to use for this session.

LT PO Usersh bradwaorkspace

| Use this as the default and do not ask again

Start Eclipse (it will be on your start menu if you chose to pin it from the previous step.) The first
time Eclipse starts it will ask you for the location of your workspace. A workspace is the location on
disk where projects and files are stored by default. You can have more than one workspace, but
it's suggested to take the default location until you have more experience with Eclipse.
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Adding C++ to Java Eclipse

Preferences E@gi
type filter text Java o - - -
= (General N
If C++ is missing, thendo | 3
> C/Ce+ the next step, otherwise  Jge explorer

Oderel f]

= Help
= Install/Update
- [Java
> Library Hower
= Mylyn
> Remote Systems
> Run/Debug
» Specfile Editor
> Team

Terminal
= Tracing

@

skip the next step

m

When opening a Type Hierarchy

(") Open a new Type Hierarchy Perspective
i@ Show the Type Hierarchy View in the current perspective

Refactoring Java code

[C] Save all modified resources automatically prior to refacte

1| 1 [ 3

To program C++ with the Java version of Eclipse, you will to have the C++ Development Tools (CDT)
installed. To determine if they're already installed, select Window, then Preferences from the menu
bar. Then look for C/C++ on the left side of the Preferences window. If it is missing then you must

install it. The installation procedure is in the next step.
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Install Eclipse C++ Development Tools

= Install

), |

Available Software

Check the items that you wish to install.

Work with: [Mars - http://download.eclipse.org/releases/mars E

tpe filter text
e Version
Pl 000 Programming Languages
SR, RrotooE support 8.8.0.201509131935
[ 4 C/C++ Berkeley UPC (Unified Parallel C) Teolchain Suppert 8.8.0.201509131935
L (/T (g aoh alizatio 4.1.0.201509161915
@ |¥] 4= C/C++ Development Tools 8.8.0.201509131935
- Tevelopmient To0ls oo £.8.0.201509131935
[7] 4+ C/C++ Docker Container Launch Support 8.8.0.201509131935
[] 5 C/C++ IBM XLC Compiler Support 8.8.0.201509131935
[ Select All ] [ Deselect All 1 itern selected
Details
Eclipse C/C++ development toels, Binary runtime and user documentation.
Show cnly the latest versions of available software Hide items that are already instzalled

Group items by category What is already installed?
[] Show only software applicable to target environment

Contact all update sites during install to find required software

Find more software by working with the "Available Software Sites” preferences.

Finish

|

%)

hd Add...

More...

Cancel

If C/C++ is missing from the preferences window (see previous step), then it must be installed

Close the Preferences window if it's open.

Click the dropdown and select the "Mars" site as shown.

Click Next.

NoupwN =

Select Help, then Install New Software... from the menu bar.

Take the defaults for the other options and let Eclipse restart.

Scroll down to the Programming Languages section and click the arrow to expand.
Click the checkbox to choose Eclipse C++ Development Tools

When these steps are finished, and Eclipse has restarted, C++ should be an available option on the

Preferences window, and all the C++ perspectives will be available.
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Adding Java to C++ Eclipse

Preferences Ll_lgnﬂ J
type filter text Java o - - -
- General -
- Ant If Java is missing, thendo | -
> C/Ce+ the next step, otherwise e Explorer
Changeleg skip the next step |
- Help 3
e
:
ibrar How When cpening a Type Hierarchy
> Mylyn i) Open a new Type Hierarchy Perspective

- Remote Systems
> Run/Debug
» Specfile Editor
> Team
Terminal
- Tracing

®

i@ Show the Type Hierarchy View in the current perspective

Refactoring Java code

[C] Save all modified resources automatically prior to refacte

1| 1 [ 3

Lok ]|

Cancel ]

To program Java with the C++ version of Eclipse, you will need to have the Java Development Tools
(JDT) installed. To determine if they're already installed, select Window, then Preferences from the
menu bar. Then look for Java on the left side of the Preferences window. If it is missing then you
must install it. The installation procedure is in the next step. If you do have the Java development
tools installed (Java is shown), then skip the next step and continue configuring to Setting up the

JDK'in Eclipse.
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Install Eclipse Java Development Tools

Available Software

Check the items that you wich to instsll V=
O
N N
Work wit -
o 5 ¥ veoikan 3 es” preferenc

Wersion

BAD.20140811173%
3002014061040
B.4.0.20140611175,
8402014061175
1002040611175
BA4.0.20140511175
1102014081175, =
1202004052712
8402014061175
8402040611175
210201405101
2107201406081
ipmatch 21.0,V2014006-1
kit - iTcl Development Tools 5.0.0.20130506070
Languages Toolkit - Ruby Development Tools 5002013050670
Languages Toolkit - TEL Development Tools 0020120806070

% Tools 5.0.0.20130606070
¥ lg> Eclipse Java Development Tools ] 3100420140606

302014050621

| sesectan Dﬁe\exlml: 1item selected

Details

7| Show only the latest versions of available software (] Hidle items that are alrcady installed
7] Group items by categery What is slready installed?
|| 1 show enly saftware applicable ta target enviranment

] Contact all update sites during install to find required software

" < Next > f [sCancs

If Java is missing from the preferences window (see previous step), then it must be installed

Close the Preferences window if it's open.

Select Help, then Install New Software... from the menu bar.

Click the dropdown and select the "Mars" site as shown.

Scroll down to the Programming Languages section and click the arrow to expand.
Choose Eclipse Java Development Tools

Click Next.

Take the defaults for the other options and let Eclipse restart.

NoupwN =

When these steps are finished, and Eclipse has restarted, Java should be an available option on the
Preferences window, and all the Java perspectives will be available.

Installing Eclipse (C++/Java) Last Updated: 01-07-2017 Page 11



Installing Eclipse (C++/Java)

Setting up the JDK in eclipse (Java teams only)

Preferences ﬁ%

| | type filter tet Installed JRE=z o T r -
Appearance - . .o : .
Build Path Add, rernove or edit JRE definstions. By default, the checked IRE is added to the build path of nestdy created Java -
projects,
Code tyile
Compiler Installed JREs:
Debug ! il Add J =
# Irectalled JRE= r o B el B0 M., ChProgram Files (2861 Javaljdk1.8.0_20 Standard ... Edit..
Mnrt . [ Cluplicate... |
Properties Files Editor | Remove |
Library Howver
Mybyn Search...
Remate Suctems i -
'] = L3
2 . oKk || Cancel |

Select Windows from the menu bar, then Preferences. Choose Java preferences in the list on the
left of the Preferences window, then Installed JREs. Be sure that the installed |DK is selected as
shown -t(make sure the "Location" field includes jdk 8 or 1.8, the name field may be the same in
either location). This will enable eclipse to build Java programs for the RoboRIO. Without this
setting you will see error messages about the JRE path not being set correctly.

If you do not see any option with the appropriate location, see the next step "Adding the JDK". If
you do have the appropriate option, skip the next step.
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Adding the JDK

& Preferences, 8 X
© Add IR ==
peiierd ——— oo
. Genersl | | JRE Type [\ | Esuiapetn

e
cronge | instaeasre ()
nstalled R Types: -
, Help
dd...
oy oo
o

B x®
Installed JREs [Chd A
Add, emave or et IRE dfiitions. By defou the checked JRE s added to the buld path
of newly crested Jovaprojects
© Add I 8] %
, Help
» Tnstall/Update JRE Defini ~
» Appearance
> Build Path
. CodeSyle || IREhome: CiProgram Files ovajckL 70,51 Diectory.
g ;“L“”“E' JRE name: mmo
» Debug
* Editor Srowse For Folder — p— =)

Select the root directory of the RE instalstion:

> 1 Intemet Explorer
> 1L MiFoundation
o)l Java
)] jda70.51
bin
> 1L db
include
> jre
> tib

> U et
[ e LSl Softhod:

) oider:  1k17.051
@ Fold

Ci\Program Files (86}

Only ilf the JDK is not shown in the step above:

Click Add
Select Standard VM

Click Next
Click Directory and browse to the folder for the JDK (usually C:\Program Files\Java\* or

C:\Program Files (x86)\Java\*). The image shows jdk1.7.0_51, you will likely have a
jdk1.8.* version.

Click OK. Pick a name for the JRE such as JDK8.

Click Finish

Make sure the box for the newly added JDK entry is checked.

PwN =

Nowm
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Configuring eclipse

-
= Preferences

=)

e filter text

I
4 General
. Appearance
Compare/Patch
Content Types
. Editors

Keys

Perspectives
Search
- Security
- Startup and Shutdoy
Web Browser
- Workspace
» Ant =
> CfCe+
Changeleg
- Help
+ Install/Update
» Java
. Library Hover
- Mylyn
. Remote Systems
- Run/Debug
4 n 3

. Metwork Connectiot

Workspace L= v

See 'Startup and Shutdown' for workspace startup and shutdown preferences,

Build automatically

[] Refresh using native hooks or polling

Refresh on access

Save automatically before build

[] Always close unrelated projects without prompt

Workspace save interval (in minutes): 5

Workspace name (shown in window title):

Open referenced projects when a project is opened

) Always () Never @ Prompt
Text file encoding Mew text file line delimiter
@ Default (Cpl252) @ Default (Windows)

) Other: | Cpl252 7 Other | Windows

I Restore DefaultsJ I Apply

)

e_ oK l I Cancel

)

There are a huge number of configuration options for eclipse to set up the environment for your
preferences. One suggested setting to note is: "Save automatically before build." This setting will
cause all of your workspace changes to be saved when you build the project. If you don't set this,
remember to save changes before building, otherwise the rebuilt program won't reflect your

newest updates.

To set this, go to Window -> Preferences -> General -> Workspace -> Check Save automatically

before build -> OK
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Automatic Updates

r b
= Preferences l_I_I_JEI e e
type filter text Automatic Updates (=T T

> G |

Ae:era [¥] Automatically find new updates and notify me
> An
» CfC++

Changelog Update schedule
:» Help o ook for updates each time Eclipse is started
a ) Look for updates en the following schedule:

Avallable Sottware Sites
> Java
> Library Hover
> Mylyn
> Remote Systems
> Run/Debug
> Specfile Editor
> Team
Terminal
> Tracing
> WPILib Preferences

Il m b

Every day 1:00 AM

Download optiens
@ Search for updates and notify me when they are available

) Download new updates automatically and netify me when ready to install them

When updates are feund

@ Motify me once about updates

) Remind me about updates eveny:
30 minutes

["] Directly show update wizard

’ Restore Defaults] ’ Apply

)

T |

Cancel

)

a

Another recommended setting is enabling Automatic Updates. With Automatic Updates enabled,
Eclipse will check for updated versions of the plugins each time it starts and inform you if an
update is available. This will help insure you are notified of new versions of the WPILib plugins.

To enable Automatic Updates, select Install/Update then Automatic Updates. Check the box at the
top to Automatically find new updates and notify me. Select the radio button to Look for updates
each time Eclipse is started. Then click OK.
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Installing the development plugins - Option 1: Online Install

=@
i@ Welcome E
(Z) Help Contents
4 Search be

Dynamic Help

Key Assist.., Ctrl+Shift+L
Tips and Tricks...

Report Bug or Enhancement... ot
Cheat Sheets...

% Check for Updates
4+ Install New Software.
et

< Install

Available Software

Select a site or enter the location of a site.

Work with:® [type or select a site]

Find more software by working with the "Available Software Sites” preferences.

& Add Repository &J
—
Location: http:_a'_ffirst.wpi.edu_a'FRCa'rDborio_a'relaase.a'eclipse.fe
-—
= o
':?)' [ OK e [ Cancel ]
N
L ]

It is recommended to install the plugins using this method, which requires an active internet

connection and fetches the plugins directly from the WPILib site. This will allow you to check for

updates to the plugins using Eclipse.

Eclipse extensions are based on user-installed plugins. To get the WPILib development tools you

will need to install the correct plugin for your language.
When Eclipse starts:

1. Select "Help"
2. Click "Install new software".

3. From here you need to add a software update site, the location where the plugins will
be downloaded. Push the "Add..." button then fill in the "Add Repository" dialog with:

Name: FRC Plugins

Location: http://first.wpi.edu/FRC/roborio/release/eclipse/
Click "OK".

o u ks
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Selecting the correct plugins

2 Install B[
Available Software
~
Check the items that you wish to install. \jl
Work with:  WPILib Release - http://first wpicdu/FRC/obori [ Add.

type fitter text

ne
153 [7] 100 WPILib Robot Development

a] (§- Robot C++ Development
7] (- Robot Java Development

Select All Deselect All 2items selected
Details

latest versions of available software

cable to target environment

.
@

Contact all update sites during install to find required software

Find more software by working with the "Avzilable Software Sites” preferences.

Version

0102014101546
0102014101156

Next > Finish Cancel

2 security Waming

Warming: Yo
B or ualciy of this softw
installation?

You are installing software that contains unsigned content,
are cannot be established. Do you want to con

[_gﬂ (o] [omainrs

The authenticity
tinue with the

ey
2 Software Updates =)
@) Voo vill necdto restort Eclipse for the changes o take effect. Would you ke to
) restart nowt
-

N —

Click the arrows if necessary to expand the WPILib Robot Development menu.
Select the WPILib Robot Development plugin for your desired language (you can install

both if you wish to try programming in both languages)

3. Click Next, Next on the next page, then click the radio button to accept the license

agreement and click Finish

v A

If you receive a Security Warning prompt, click OK to continue.
When prompted, restart Eclipse. After Eclipse restarts and you select your Workspace (if
prompted) you will see a dialog that says Installing Java. This details the installation

progress of the plugins, wait for the install to complete before proceeding. This dialog

should only appear when the plugins are first installed or updated.
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Installing the development plugins - Option 2: Download and

install offline
=0

i 5 Welcome p

() Help Contents
4 Search be

Dynamic Help

Key Assist... Ctrl+Shift+L
Tips and Tricks...

4 Report Bug or Enhancement... pt
Cheat Sheets... F

% Check for Updates
g Install New Software.|
4

£ Install

Available Software

Select a site or enter the location of a site,

Work with:® -
Find more software by working with the "Available Software Sites” preferences.
= Add Repository &r
|
Mame: FRC p\uginsg e

Location: http:_a'_ffirst.wpi .edu/FRC/roborio/release/eclipse/

Ii?:l [ OK@ [ Cancel ]

If you need to download the plugins and install them on a different machine offline, you will be

unable to check for updates using Eclipse. Download the zipfile containing the plugins
from-thttp://first.wpi.edu/FRC/roborio/release/ Right click on the zip and select Extract All to

extract the files.
When Eclipse starts:

1. Select "Help"
Click "Install new software".

W N

then fill in the "Add Repository" dialog with:
Name: FRC Plugins Offline
Click Local

Nowuhk

Click "OK".
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Browse to the "site" directory inside the directory you extracted the zip file to.

From here you need to add the downloaded plugin location. Push the "Add..." button
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Selecting the correct plugins

N —

v A

If updated plugins are released, you can either repeat this process ( you will get one additional
Eclipse window telling you that the components are already installed and an upgrade will be
performed instead of an install), or if online installation is an option, you can complete the online
installation steps above, then get future updates using the Eclipse Automatic Updates (or the

2 Install B[
Available Software
Check the items that you wish to install. )l_
Work with:  WPILib Release - http://first.wpi.ecu/FRC/roborio/release/eclipse/ - Add..
Find more software by working with the “Available Software Sites” preferences.
type filter text
one Version
153 [7] 100 WPILib Robot Development
°1 (§- Robot C++ Development 0.1.0201410111546
(7] (5 Robot Java Development 010201410111546
Select Al Deselect All 2 items selected
Details
] 5how only the latest of available software ] Hide items that are already installed
] Group items by ca What s already installed?
Show only software applicable to target environmant
] Contact all update sites during install to find required software
@ < Bac Next > Finish Cancel
2 Security Waming (R X
< installing software that cantains unsigned content, The authenticity
B\ or ualicity of this software cannot be established. Do you want to continue with the
instal H
oK [ concel ][ Detoitsz> |
SRS VY
2 Software Updates =)
@D You will need to restart Eclipse for the changes to take effect. Would you like to
restart now?
=

manual update check described below)
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Click the arrows if necessary to expand the WPILib Robot Development menu.

Select the WPILib Robot Development plugin for your desired language (you can install
both if you wish to try programming in both languages)
Click Next, Next on the next page, then click the radio button to accept the license
agreement and click Finish
If you receive a Security Warning prompt, click OK to continue.
When prompted, restart Eclipse. After Eclipse restarts and you select your Workspace (if
prompted) you will see a dialog that says Installing Java. This details the installation
progress of the plugins, wait for the install to complete before proceeding. This dialog
should only appear when the plugins are first installed or updated.
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Updating the plugins manually

| pluginsVerification - Parallels Desktop

ib Run Window [Help |

v A |.:E,| Welcome r - i
B (%) Help Contents
@ // Name @y- search
Dynarnic Help
F Hame Key Assist... Ctrl+Shift+L
i %Uth?F Tips and Tricks...
/i Version
// Copyright &f' Report Bug or Enhancement...
// Descriptic Cheat Sheets..
. Eclipse Marketplace...
#include "WPI
Check for Updates
= class Robot ¢ Install Mew Software..
private:
LiveWindg About Eclipse

= virtual void RobotInit() {

Tw = I dweldindrwe «GatTRetanca

Note: This only works if the plugins were installed using Option 1 - Online Install from above. For
updating plugins when the offline install was used, see the note at the end of the step above.

If you choose not to enable Automatic Updates as described above, you will need to manually have
Eclipse check for updates to install new versions of the plugins.

Select Help from the menu bar, followed by Check for updates. Eclipse will check if there is a newer

version available of any installed plugin and inform you if an update is found. Updating the plugins
will ensure that your development system is up to date with the latest version of the development

tools.

Troubleshooting

Below are some troubleshooting steps for commonly encountered issues
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Unable to read repository at http://first.wpi.edu/FRC/roborio/release/

eclipse/content.xml,Au

- & Preferences

type filter text

a4 General
- Appearance
Compare/Patch
Content Types
» Editors
Globalization
Keys
> Network Connectior
Perspectives
Search
- Security
> Startup and Shutdoy
Web Browser
- Workspace
> Ant
s IC++
Changelog
> Help
> Install/Update
> Java
> Library Hover
> Mylyn
> Remote Systems
] n b

L | 5
Network Connections Ll A 4
Active Provider
Proxy entries
Sche.. Host Pert Provi... Auth User Edit...
[F] HTTP Man... Mo
Clear
[[] HTTPS Man... No
[] SOCKS Man... No
] i r
Prowxy bypass
Host Provider Add Host...
[[] localhost Manual Edit
] 1z7.001 Manual
Remove
[Restore Defaults] [ Apply ]
[ QK l ’ Cancel ]

This error occurs if Eclipse cannot contact the server to download the plugins. There are a couple

possible causes of this issue:

1. Your computer is not connected to the Internet. Verify your network connection and try

again.

2. Your firewall is blocking Eclipse. Try adding an exception for Eclipse or disabling your

Firewall.

3. Your proxy settings were read improperly by Eclipse. In Eclipse Select Window-
>Preferences->General->Network Connections. If you don't use a proxy or don't know,
set the Active Provider to Direct. If you use a proxy set the Active Provider to Manual and
configure the proxy information by selecting the protocol and clicking Edit.

Need Java 1.7 or newer

If you get an error message when attempting to run Eclipse that says you "need Java 1.7 or newer",
you have mismatched versions of Java and Eclipse installed. The easiest fix is to go back and
download the other version of Eclipse (32 bit if you had 64, 64 if you had 32).
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